


How to Contact The MathWorks

www.mathworks.com Web
comp.soft-sys.matlab Newsgroup

suggest@mathworks.com Product enhancement suggestions
bugs@mathworks.com Bug reports
doc@mathworks.com Documentation error reports
info@mathworks.com Sales, pricing, and general information

508-647-7000 (Phone)

The MathWorks, Inc.
3 Apple Hill Drive
Natick, MA 01760-2098
For localities outside the U.S., see the MathWorks Web site.

MATLAB® & Simulink® Student Version Introduction and Installation Instructions

© COPYRIGHT 1984–2009 by The MathWorks, Inc.
The software described in this document is furnished under a license agreement. The software may be used
or copied only under the terms of the license agreement. No part of this manual may be photocopied or
reproduced in any form without prior written consent from The MathWorks, Inc.

FEDERAL ACQUISITION: This provision applies to all acquisitions of the Program and Documentation
by, for, or through the federal government of the United States. By accepting delivery of the Program
or Documentation, the government hereby agrees that this software or documentation qualifies as
commercial computer software or commercial computer software documentation as such terms are used
or defined in FAR 12.212, DFARS Part 227.72, and DFARS 252.227-7014. Accordingly, the terms and
conditions of this Agreement and only those rights specified in this Agreement, shall pertain to and govern
the use, modification, reproduction, release, performance, display, and disclosure of the Program and
Documentation by the federal government (or other entity acquiring for or through the federal government)
and shall supersede any conflicting contractual terms or conditions. If this License fails to meet the
government’s needs or is inconsistent in any respect with federal procurement law, the government agrees
to return the Program and Documentation, unused, to The MathWorks, Inc.

Trademarks

MATLAB and Simulink are registered trademarks of The MathWorks, Inc. See
www.mathworks.com/trademarks for a list of additional trademarks. Other product or brand
names may be trademarks or registered trademarks of their respective holders.

Patents

The MathWorks products are protected by one or more U.S. patents. Please see
www.mathworks.com/patents for more information.

Revision History
April 2007 First printing Rewritten for Release 2007a
March 2008 Online only Release 2008a
October 2008 Online only Release 2008b
March 2009 Online only Release 2009a

http://www.mathworks.com/trademarks
http://www.mathworks.com/patents


Contents

Introducing MATLAB & Simulink Student
Version

1
What Is Student Version? . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2
Student Use Policy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2

Quick Start . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3
Installing Student Version . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3
Student Version Activation . . . . . . . . . . . . . . . . . . . . . . . . . 1-3
Learning the MATLAB Programming Language . . . . . . . . 1-5
Learning to Use Simulink Software . . . . . . . . . . . . . . . . . . . 1-6

Student Version Overview . . . . . . . . . . . . . . . . . . . . . . . . . . 1-9
What You Can Do with Student Version . . . . . . . . . . . . . . . 1-9
Products Included in Student Version . . . . . . . . . . . . . . . . . 1-9

Obtaining Additional MathWorks Products . . . . . . . . . . 1-14

Finding Reference Information . . . . . . . . . . . . . . . . . . . . . 1-15

Other Resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-17
MathWorks Web Site . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-17
Technical Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-18

Installation Instructions

2
Installing on Microsoft Windows Platforms . . . . . . . . . . 2-2
System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
Installing and Activating Student Version . . . . . . . . . . . . . 2-3
Installing Additional Products . . . . . . . . . . . . . . . . . . . . . . . 2-5

iii



Installing on Apple Macintosh Computers . . . . . . . . . . . 2-6
System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-6
Installing and Activating Student Version . . . . . . . . . . . . . 2-7
Installing Additional Products . . . . . . . . . . . . . . . . . . . . . . . 2-12
Documentation for Macintosh Computers . . . . . . . . . . . . . . 2-12

Installing on Linux Operating System Platforms . . . . . 2-13
System Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-13
Installing and Activating Student Version . . . . . . . . . . . . . 2-14
Installing Additional Products . . . . . . . . . . . . . . . . . . . . . . . 2-19

Index

iv Contents



1

Introducing MATLAB &
Simulink Student Version

• “What Is Student Version?” on page 1-2

• “Quick Start” on page 1-3

• “Student Version Overview” on page 1-9

• “Obtaining Additional MathWorks Products” on page 1-14

• “Finding Reference Information” on page 1-15

• “Other Resources” on page 1-17
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What Is Student Version?
If you are studying engineering, science, math, or finance, then MATLAB® &
Simulink® Student Version is your essential technical computing resource.

Student Version includes full-featured versions of both the MATLAB and
Simulink software, used by engineers, scientists, and mathematicians at
leading universities, research laboratories, technology companies, and
government laboratories around the world. Student Version also includes
several other MathWorks™ software add-ons that help you do course work
in the areas of signal processing, control design, statistics, optimization, and
symbolic computing.

For more information about what Student Version contains and what you can
do with it, see “Student Version Overview” on page 1-9.

Student Use Policy
The Student Version License is for use in conjunction with courses offered at
degree-granting institutions. The MathWorks offers this license as a special
service to the student community and asks your help in seeing that its terms
are not abused.

To use this Student License, you must be a student either enrolled in
a degree-granting institution or participating in a continuing education
program at a degree-granting educational university.

You may not use this Student License at a company or government
laboratories. Also, you may not use it if you are an instructor at a university,
or for research, commercial, or industrial purposes. In these cases, you can
acquire the appropriate professional or academic license by contacting The
MathWorks (www.mathworks.com).
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Quick Start

Quick Start

In this section...

“Installing Student Version” on page 1-3

“Student Version Activation” on page 1-3

“Learning the MATLAB Programming Language” on page 1-5

“Learning to Use Simulink Software” on page 1-6

Installing Student Version
MATLAB & Simulink Student Version includes MATLAB, Simulink, and
seven other MathWorks products.

Perform the installation by inserting the Student Version DVD and following
the instructions in the dialog boxes presented by the Student Version
installation program. For additional details, see Chapter 2, “Installation
Instructions”.

Student Version Activation
An important part of the installation process is activation.

Activation is a secure process that verifies licensed student users. This
process validates the serial number and ensures that it is not used on more
systems than allowed by The MathWorks, Inc. Software License Agreement.
Activation requires you to provide:

• Registration information by creating a MathWorks Account

• The serial number and the Machine ID for the computer on which you
are installing the software

• Proof of student status, if you did not provide proof of student status at
the time of purchase

The easiest way to activate your software is to use the activation program
that starts following product installation. The activation program guides
you through the activation process.
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For more information about activation, see
www.mathworks.com/academia/student_version/activation.html.
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Learning the MATLAB Programming Language
At the heart of the MATLAB technical computing environment is a
programming language that you must learn before you can fully exploit its
power. You can learn the basics quickly, and mastery will come shortly
thereafter. You will be rewarded with highly productive, highly creative
computing power that will change the way you work.

What I Want What I Should Do

Install and
activate
MATLAB

See Chapter 2, “Installation Instructions”

Start MATLAB (Microsoft® Windows® Platforms) Double-click the MATLAB icon on your
desktop.

(Apple®Macintosh® Computers) Double-click the MATLAB icon in the
MATLAB installation folder (Applications, by default).

(Linux® operating systems; Linux is a registered trademark of Linus
Torvalds.) Enter the matlab command at the command prompt.

Learn
MATLAB
quickly

• View the MATLAB tutorial designed for students at
http://www.mathworks.com/academia/matlabtutorial.

• View the online demo videos, as follows:

1 Start MATLAB.

2 In the MATLAB Help Navigator, click the Demos tab.

3 Click MATLAB.

4 In the Help browser pane, click the name of a demo video.

You also can find a large selection of demos at www.mathworks.com/demos.

• View the recorded Introduction to MATLAB webinar at
http://www.mathworks.com/company/events/webinars/wbnr30480.html.

You will be asked to create a MathWorks account before proceeding to the
webinar.

• Read the MATLAB Getting Started Guide.
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What I Want What I Should Do

The most important things to learn are how to enter matrices, how to use the :
(colon) operator, and how to invoke functions. After you master the basics, you
can access the rest of the documentation through the online help facility (Help).

Print this
document

To print this document, you need a PDF reader, such as an Adobe® Acrobat®

product. The PDF reader opens a .pdf file and reproduces the look and feel of
a printed book online.

1 In a Web browser, go to the following URL:
http://www.mathworks.com/access/helpdesk/help/helpdesk.html.

2 Search for Student Version and then click the link for the associated .pdf
file.

The PDF reader opens, displaying this document.

3 In the PDF reader, select File > Print.

If you are using The Open Group UNIX® platform and cannot open the PDF
documentation, check the MATLAB Help preferences. For more information,
see “PDF Reader — Specifying Its Location” in the Desktop Tools and
Development Environment documentation.

Find detailed
information
about using
MATLAB and
troubleshooting.

See “Finding Reference Information” on page 1-15 and “Other Resources”
on page 1-17.

Learning to Use Simulink Software
You can quickly learn how to use Simulink for modeling, simulating, and
analyzing dynamic systems.
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What I Want What I Should Do

Start Simulink (Windows Platform) Double-click the MATLAB icon on your desktop.
Click the Simulink icon on the toolbar to start Simulink.

(Macintosh computers) Double-click the MATLAB icon in the MATLAB
installation folder (Applications, by default). Click the Simulink icon
on the toolbar to start Simulink.

(Linux operating systems) Enter the matlab command at the
command prompt. Click the Simulink icon on the toolbar.

Learn Simulink
quickly

• View the Simulink tutorial designed for students at
http://www.mathworks.com/academia/simulinktutorial.

• View the online demo videos, as follows:

1 Start Simulink.

2 Click Help > Simulink.

3 In the Help Navigator, click the Demos tab.

4 Click Simulink.

5 In the Help browser pane, click the name of a demo video.

You also can find a large selection of demos at
www.mathworks.com/demos.

• View a recorded webinar at
http://www.mathworks.com/company/events/webinars.

• Read the Simulink Getting Started Guide.

You will learn how to model, simulate, and analyze dynamic systems.
Because Simulink is graphical and interactive, you can start using
Simulink quickly. After you master the basics, you can access the rest of
the documentation through the online help facility (Help).
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What I Want What I Should Do

Print this document To print this document, you need a PDF reader, such as an Adobe Acrobat
product. The PDF reader opens a .pdf file and reproduces the look and
feel of a printed book online.

1 In a Web browser, go to the following URL:
http://www.mathworks.com/access/helpdesk/help/helpdesk.html.

2 Search for Student Version and then click the link for the associated
.pdf file.

The PDF reader opens, displaying this document.

3 In the PDF reader, select File > Print.

If you are using The Open Group UNIX platform and cannot open the
PDF documentation, check the MATLAB Help preferences. See “PDF
Reader — Specifying Its Location” in the Desktop Tools and Development
Environment documentation for more information.
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Student Version Overview

In this section...

“What You Can Do with Student Version” on page 1-9

“Products Included in Student Version” on page 1-9

What You Can Do with Student Version
Student Version includes MATLAB and Simulink software, the premier
software packages for technical computing in education and industry. Student
Version provides all of the features of the professional version of MATLAB
software, with no limitations, and the full functionality of the professional
version of Simulink software, with model sizes up to 1000 blocks. Student
Version gives you immediate access to high-performance numeric computing,
modeling, and simulation power. Student Version also includes several other
MathWorks software add-ons in areas such as controls, signal processing,
statistics, image processing, and more.

MathWorks software is used in a broad range of industries, including
automotive, aerospace, electronics, environmental, telecommunications,
computer peripherals, finance, and medicine. More than one million technical
professionals rely on MATLAB and Simulink as the fundamental tools for
their engineering and scientific work at the world’s most innovative

• Technology companies

• Government research laboratories

• Financial institutions

• Universities (more than 3500 universities)

Products Included in Student Version

MATLAB
MATLAB is a high-level language and interactive environment that lets you
focus on your course work and applications, rather than on programming
details. It enables you to solve many numerical problems in a fraction of the
time it takes to write a program in a lower level language such as Java™,
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C, C++, or Fortran. You can also use MATLAB to analyze and visualize
data using automation capabilities, avoiding the manual repetition common
with other products.

Programming and developing algorithms is faster with MATLAB than with
traditional languages because MATLAB supports interactive development,
without the need to perform low-level administrative tasks, such as
declaring variables and allocating memory. Thousands of engineering and
mathematical functions are available, eliminating the need to code and test
them yourself. At the same time, MATLAB provides all the features of a
traditional programming language, including arithmetic operators, flow
control, data structures, data types, object-oriented programming (OOP),
and debugging features.

MATLAB helps you better understand and apply concepts in a wide range
of engineering, science, and mathematics applications, including signal and
image processing, communications, control design, test and measurement,
financial modeling and analysis, and computational biology. Add-on toolboxes
(collections of task- and application-specific MATLAB functions, available
separately) extend the MATLAB environment to solve particular classes of
problems in these application areas.

With over 1,000,000 users, MATLAB is recognized as a standard tool for
increasing the productivity of engineers and scientists. Employers worldwide
consistently report the advantages of being MATLAB proficient.

Student Version Differences. There are a few small differences between
Student Version and the professional version of MATLAB software:

• The MATLAB prompt in Student Version is

EDU>>

• Printouts contain the footer:

Student Version of MATLAB

Simulink
You can use the Simulink interactive tools for modeling, simulating,
and analyzing dynamic systems, including controls, signal processing,
communications, and other complex systems. It supports linear and nonlinear
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systems, modeled in continuous time, sampled time, or a hybrid of the two.
Systems can also be multirate, i.e., have different parts that are sampled or
updated at different rates.

Simulink encourages you to try things out. You can easily build models from
scratch, or take an existing model and add to it. You have instant access
to all the MATLAB analysis tools, so you can take the results and analyze
and visualize them. A goal of Simulink is to give you a sense of the fun of
modeling and simulation through an environment that encourages you to
pose a question, model it, and see what happens.

Simulink is also practical. With thousands of engineers around the world
using it to model and solve real problems, knowledge of this tool will serve
you well throughout your professional career.

Student Version Differences.

• Accelerator and Rapid-Accelerator simulation modes are not available in
Student Version.

• Model reference blocks can be used in Normal mode only.

• Models, including the blocks in referenced models, are limited to 1000
blocks.

• Printouts contain the footer:

Student Version of MATLAB.

Additional Products Included
Student Version includes several other add-on products, that extend MATLAB
and Simulink.
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Product Description

Control System Toolbox™ Tools for systematically analyzing, designing,
and tuning linear control systems. You
can specify a linear model of your system;
plot its time and frequency responses to
understand how the system behaves; tune
the controller parameters using automated
and interactive techniques; and verify
performance requirements, such as rise time
and gain/phase margins.

Signal Processing Toolbox™ Industry-standard algorithms for analog and
digital signal processing.

Signal Processing Blockset™ Efficient frame-based processing and
Simulink blocks for designing, implementing,
and verifying signal processing systems. The
blockset enables you to model streaming data
and multirate systems in communications,
audio/video, digital control, radar/sonar,
consumer and medical electronics, and other
numerically intensive application areas.

Statistics Toolbox™ Statistical tools to assess and understand
numeric data. It includes functions and
interactive tools for analyzing historical
data, modeling data, simulating systems,
developing statistical algorithms, and
learning and teaching statistics.

Optimization Toolbox™ Widely used algorithms for standard and
large-scale optimization. These algorithms
solve constrained and unconstrained
continuous and discrete problems. The
toolbox includes functions for linear
programming, quadratic programming,
nonlinear optimization, nonlinear
least squares, nonlinear equations,
multiobjective optimization, and binary
integer programming.
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Product Description

Image Processing Toolbox™ Reference-standard algorithms and
graphical tools for image processing,
analysis, visualization, and algorithm
development. You can restore noisy or
degraded images, enhance images for
improved intelligibility, extract features,
analyze shapes and textures, and register
two images.

Symbolic Math Toolbox™ Tools for solving and manipulating
symbolic math expressions and performing
variable-precision arithmetic. The toolbox
contains hundreds of MATLAB symbolic
functions that leverage the MuPAD®

engine for tasks such as differentiation,
integration, simplification, transforms, and
equation-solving.

Symbolic Math Toolbox also includes the
MuPAD language, which is optimized for
handling and operating on symbolic math
expressions. It provides libraries of MuPAD
functions in common mathematical areas,
such as calculus and linear algebra, as
well as specialized areas, such as number
theory and combinatorics. You can extend
the built-in functionality by writing custom
symbolic functions and libraries in the
MuPAD language. All functions can be
accessed from within MATLAB or from the
MuPAD Notebook Interface, where you
can manage and document your symbolic
computations

Demos. Student Version includes many product demos. For example, a demo
version of Stateflow® software lets you edit and run Simulink models. You
can use Stateflow to design and simulate state machines and control logic.
However, the demo version does not let you save models.
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Obtaining Additional MathWorks Products
Many college courses recommend MATLAB and Simulink products as
standard instructional software. In some cases, the courses require
particular toolboxes, blocksets, or other products. Toolboxes and blocksets are
add-on products that extend MATLAB and Simulink with domain-specific
capabilities. Some of these products are included with Student Version, and
many more are available separately for use with Student Version. You may
purchase and download these additional products at special student prices
from the MathWorks Store at www.mathworks.com/store.

Some examples of the products you can purchase include:

• Bioinformatics Toolbox™

• Communications Blockset™

• Financial Toolbox™

• Fuzzy Logic Toolbox™

• Neural Network Toolbox™

• Stateflow (A demo version of Stateflow software is included with your
Student Version.)

For an up-to-date list of available products and their product dependencies,
visit the MathWorks Store.

Note The additional toolboxes and blocksets that are available for use with
Student Version have the same functionality as the professional versions
(with the exception of SimMechanics™ software, which has a 20-body
limitation). However, the student versions of the toolboxes and blocksets will
work only with Student Version. Likewise, the professional versions of the
toolboxes and blocksets do not work with Student Version.
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Finding Reference Information

What I Want What I Should Do

How to use a specific function You have several choices, including:

• From the command line, use the help
command (for example, help print) to
see help text in the Command Window,
or the doc command (for example, doc
print) to see the reference page in the
Help browser.

• Use the online help facility (Help).
To access Help, use the command
helpbrowser or use the Help menu. In
the Help browser, select a product in the
Contents pane, and then Functions —
Alphabetical List.

Find a function for a specific
purpose, but I do not know
the function name

You have several choices, including:

• In the Help browser, select a product in
the Contents pane, and then Function —
By Category.

• Use Index or Search in the Help
browser.

• Use lookfor (for example, lookfor
inverse) from the command line.

What functions are available
in a general area

Use the Help browser to view Functions
— By Category for a product or use Index
or Search.

How to use a specific block In the Help browser, click either a Simulink
product or Signal Processing Blockset, and
then Blocks — Alphabetical List.
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What I Want What I Should Do

Find a block for a specific
purpose, but I don’t know the
block name

You have several choices, including:

• In the Help browser, select Blocks — By
Category.

• Use Index or Search in the Help
browser.

What blocks are available in
a general area

Use the Help browser to view Blocks —
By Category for a product or use Index or
Search.

Learn about a specific topic
such as sparse matrices,
ordinary differential
equations, or cell arrays

Use Help to locate the appropriate sections
in the documentation for the MATLAB,
Simulink products, or for another product
included with Student Version (for example,
MATLAB > Mathematics > Sparse
Matrices).
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Other Resources

In this section...

“MathWorks Web Site” on page 1-17

“Technical Support” on page 1-18

MathWorks Web Site
At www.mathworks.com, there is information about MathWorks products
and how they are used in education and industry, product demos, and books
about MATLAB and Simulink software.

Web-Based Documentation
Documentation for all MathWorks software is available from the Support area
of the MathWorks Web site. In addition to tutorials and function reference
pages, you can find PDF versions of all the manuals.

MathWorks Academia Web Site
At www.mathworks.com/academia, you will find resources for students for
courses in engineering, mathematics, and science.

Books about Using MATLAB and Simulink Software
At www.mathworks.com/support/books, you will find books in many
disciplines that use MATLAB and Simulink for examples and assignments.

The MathWorks Store
At www.mathworks.com/store, you can purchase add-on products and
documentation.

MATLAB Central — File Exchange/Newsgroup Access
At www.mathworks.com/matlabcentral, you can access the MATLAB
Usenet comp.soft-sys.matlab newsgroup, as well as an extensive library of
user-contributed files called the MATLAB Central File Exchange. MATLAB
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Central is also home to the Link Exchange where you can share your favorite
links to various educational, personal, and commercial MATLAB Web sites.

The comp.soft-sys.matlab newsgroup is for professionals and students who
use MATLAB and have questions or comments about it and its associated
software. This is an important resource for posing questions and answering
queries from other MATLAB users. MathWorks staff also participates
actively in this newsgroup.

Technical Support
At www.mathworks.com/support, you can get technical support.

Telephone and e-mail access to our technical support staff is not available
for students running Student Version unless you are experiencing difficulty
installing or downloading MATLAB or related products. There are numerous
other vehicles of technical support that you can use.

If you experience a problem that is unrelated to installing MATLAB or related
products, first check the available MathWorks sources for help. If you still
cannot resolve your problem, contact your instructor. Your instructor should
be able to help you. (Telephone and e-mail technical support is available to
registered instructors who have adopted Student Version in their courses.)
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Installation Instructions

This chapter describes how to install and activate Student Version.

• “Installing on Microsoft Windows Platforms” on page 2-2

• “Installing on Apple Macintosh Computers” on page 2-6

• “Installing on Linux Operating System Platforms” on page 2-13
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Installing on Microsoft Windows Platforms

In this section...

“System Requirements” on page 2-2

“Installing and Activating Student Version” on page 2-3

“Installing Additional Products” on page 2-5

System Requirements

• PC with Intel® Pentium (Pentium 4 and above), Intel Celeron, Intel Core,
Intel Xeon, AMD Athlon™ 64, AMD® Opteron, or AMD Sempron

Intel Celeron and AMD Athlon 64 must support SSE2 instruction set.

• Microsoft Windows Vista™ (Service Pack 1) or Windows XP (Service Pack 2
or 3)

• 512 MB RAM or higher (1024 MB recommended)

• 660 MB disk space (MATLAB only)

• 16-, 24-, or 32-bit OpenGL® capable graphics adapter

Note For detailed and current information on system requirements, visit
www.mathworks.com/academia/student_version/requirements.html.

MEX-Files
MEX-files are dynamically linked subroutines that MATLAB can
automatically load and execute. They provide a mechanism by which you
can call your own C and Fortran subroutines from MATLAB as if they were
built-in functions.

If you plan to build your own MEX-files, you need a supported compiler. For
the most up-to-date information about compilers, see the support area at the
MathWorks Web site (www.mathworks.com).
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Installing and Activating Student Version

1 Exit any existing copies of MATLAB you have running.

2 Insert the Student Version DVD in your DVD drive. The installation script
should launch automatically. If the installation script does not launch in a
short time, run setup.exe from the DVD.

3 Read the MathWorks Installer dialog box, and then click Next.

4 Review the software licensing agreement and, if you agree with the terms,
select Yes and click Next.

5 Select the installation type and click Next.

Typical installation installs all products. Custom installation gives
you control over the installation, such as selecting which products to
install. This installation type is intended for advanced users who do not
need step-by-step instructions. Therefore, the remainder of these steps
provide instructions for a Typical installation.

6 Use the Folder Selection dialog box to specify the name of the folder into
which you want to install MATLAB. You can accept the default installation
folder or specify the name of a different installation folder. If the folder
does not exist, the installer creates it. To continue with the installation,
click Next.

7 Use the Confirmation dialog box to confirm your installation options. To
change a setting, click the Back button. To proceed with the installation,
click Install.

When the installation successfully completes, the activation process begins
by displaying the Activation Overview dialog box.

The Activation Overview dialog box outlines the steps for the activation
process, as follows.

Step 1. Enter your serial number and e-mail address.

Step 2. Provide registration information by creating a MathWorks account.

Some students must also complete Steps 3 and 4.
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Step 3. Provide proof of student status.

Step 4. If you receive an e-mail indicating you have been authenticated,
follow the instructions in that e-mail to complete the activation.

8 Click Next.

The Student Use Policy dialog box displays. If you are a student using
the software for course work at a school, college, or university, select Yes
and then click Next. Otherwise, select No, and then click Cancel. You
cannot use this software if you do not fit the description presented in
this dialog box.

9 Follow the steps through the activation process.

At the completion of the activation process, you can use Student Version.

In certain cases, your software is temporarily activated for 30 days until
your proof of student status is verified. In these cases, you are reminded
that your activation is temporary and that you need to complete the
activation process. After your proof of student status is verified, your
activation is complete.
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Note If you encounter a problem during the activation process, check
www.mathworks.com/academia/student_version/activation.html for more
information.

10 To start MATLAB, double-click the MATLAB icon that the installer creates
on your desktop.

11 Customize any MATLAB environment options, if desired. For example, to
specify welcome messages, default definitions, or any MATLAB expressions
that you want executed every time MATLAB is invoked, you must create
a file named startup.m. For Windows Vista operating system, create
startup.m in the Documents\MATLAB folder. For other supported Windows
platforms, create in create startup.m in the My Documents\MATLAB folder.
Every time you start MATLAB, it executes the commands in the startup.m
file.

12 Perform any additional configuration by typing the appropriate command
at the MATLAB command prompt. For example, to configure the MATLAB
Notebook, type notebook -setup. To configure a compiler to work with the
MATLAB External Interface, type mex -setup.

For More Information The Installation Guide for Windows provides
additional installation details.

Installing Additional Products
To purchase additional products, visit the MathWorks Store at
www.mathworks.com/store. After you purchase a product, the product and
its online documentation download to your computer.

When you download a product, you receive an installation program for the
product. To install the product and its documentation, run the installation
program by double-clicking the installer icon. After you successfully install
the product, all of its functionality and documentation are available to you
when you start MATLAB.
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Installing on Apple Macintosh Computers

In this section...

“System Requirements” on page 2-6

“Installing and Activating Student Version” on page 2-7

“Installing Additional Products” on page 2-12

“Documentation for Macintosh Computers” on page 2-12

System Requirements

• Intel processor

• Mac® OS X 10.5 and above

• 512 MB RAM (1024 MB recommended)

• 360 MB disk space (MATLAB only)

Note For detailed and current information on system requirements, visit
www.mathworks.com/academia/student_version/requirements.html.

MEX-Files
MEX-files are dynamically linked subroutines that MATLAB can
automatically load and execute. They provide a mechanism by which you
can call your own C and Fortran subroutines from MATLAB as if they were
built-in functions.

If you plan to build your own MEX-files, you need a supported compiler. For
the most up-to-date information about compilers, see the support area at the
MathWorks Web site (www.mathworks.com).
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Installing and Activating Student Version

Permissions
If you want to install Student Version in a particular directory, you must have
the appropriate permissions. For example, to install MATLAB software in the
Applications directory, you must have administrator status.

Note The user account you set up when you configured your Mac computer is
an administrator account. If you do not know the user name and password
for an administrator, check with the person who administers your Macintosh
computer.

To create symbolic links in a particular directory, you also need the
appropriate permissions. For information on setting permissions (privileges),
see the Apple Macintosh computer’s Help (press Command+? from the
desktop).

Installation Procedure

1 Insert the Student Version DVD in the DVD drive. When the DVD icon
appears on the desktop, double-click it to display the DVD contents.

2 Double-click the InstallForMacOSX icon to begin the installation.

A dialog box opens.

3 In the dialog box, enter a user name and password for an administrator,
and then click OK.
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4 When the MathWorks Installer window appears, review its contents.
Click Continue to proceed with the installation.

5 The Software License Agreement displays. If you agree to its terms, click
Continue to continue the installation.

6 Choose your installation location. If you accept the default, the installer
puts the MATLAB_R2009aSV application in the Applications folder on
your system disk. To accept this default, click Continue. To change the
location, click Choose Folder, and then navigate to the desired location.

Note Your installation folder name cannot contain spaces, the @ character,
the % character, or the $ character. You cannot install into a folder named
private, but you can have a folder named private on the path. To create
the installation folder in this location on your system, you must have
administrator privileges. For information on setting privileges, see the help
for the Macintosh computer (press Command+? from the desktop).
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7 Select the products you want to install from the list of products, and then
click Continue.
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8 When the installation successfully completes, the installer displays the
Installation Complete window. Click Continue to activate MATLAB.

The Activation Overview dialog box opens and lists the steps to activate
your Student Version.

You will be prompted either to complete just the first two steps, or to
complete all four steps.

Step 1. Enter your serial number and e-mail address.

Step 2. Provide registration information by creating a MathWorks account.

Some students must also complete Steps 3 and 4.

Step 3. Provide proof of student status.

Step 4. If you receive an e-mail indicating you have been authenticated,
follow the instructions in that e-mail to complete the activation.
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9 Click Next.

The Student Use Policy dialog box displays. If you are a student using the
software for course work at a school, college, or university, select Yes and
then click Next. Otherwise, select No, and then click Cancel. You cannot
use this software if you do not fit the description presented in this dialog
box.

10 Follow the steps through the activation process.

At the completion of the activation process, you will be able to use Student
Version.

In certain cases, your software will be temporarily activated for 30 days
until your proof of student status is verified. In these cases, you will be
reminded that your activation is temporary and that you need to complete
the activation process. After your proof of student status is verified, your
activation is complete.
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Note If you encounter a problem during the activation process, check
www.mathworks.com/academia/student_version/activation.html for
more information.

11 Start MATLAB by double-clicking the MATLAB icon in the MATLAB
installation folder (Applications, by default).

Note The Installation Guide for Mac OS® X provides additional installation
information.

Installing Additional Products
To purchase additional products, visit the MathWorks Store at
www.mathworks.com/store. After you purchase a product, the product and
its online documentation are downloaded to your computer.

Documentation for Macintosh Computers
In general, the documentation for MathWorks products does not vary for
individual platforms unless the product or feature is available only on a
particular platform. When there is a specific difference for the Macintosh
computers, the documentation (print or online through the Help browser) calls
out the platform differences. If you are using a Macintosh computer, make
sure you refer to the documentation for the Open Group UNIX platform.
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Installing on Linux Operating System Platforms

In this section...

“System Requirements” on page 2-13

“Installing and Activating Student Version” on page 2-14

“Installing Additional Products” on page 2-19

System Requirements

• PC with Intel Pentium (Pentium 4 and above), Intel Celeron, Intel Core,
Intel Xeon, AMD Athlon 64 (must support SSE2 instruction set), AMD
Opteron, or AMD Sempron

• Red Hat Enterprise Linux v4 and above, Fedora Core 4 and above, Debian
4.0 and above, Ubuntu 8 and above

• 512 MB RAM or higher (1024 MB recommended)

• 500 MB disk space (MATLAB only)

• 16-, 24-, or 32-bit OpenGL capable graphics adapter

Note For detailed and current information on system requirements, visit
www.mathworks.com/academia/student_version/requirements.html.

MEX-Files
MEX-files are dynamically linked subroutines that MATLAB can
automatically load and execute. They provide a mechanism by which you
can call your own C and Fortran subroutines from MATLAB as if they were
built-in functions.

If you plan to build your own MEX-files, you need a supported compiler. For
the most up-to-date information about compilers, see the support area at the
MathWorks Web site (www.mathworks.com).
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Installing and Activating Student Version

Privileges
On most systems, you need root privileges to perform certain steps in the
installation procedure.

Installation Procedure

1 Insert the Student Version DVD in the DVD drive.

If your DVD drive is not accessible to your operating system, you need to
mount the DVD drive on your system. Create a directory to be the mount
point for it:

$ mkdir /dvd

Mount a DVD drive using the command:

$ mount /dvd

If your system requires that you have root privileges to mount a DVD drive,
these commands should work on most systems:

$ su root
# mount -t iso9660 /dev/dvd /dvd

To enable nonroot users to mount a DVD drive, include the exec option
in the entry for DVD drives in your /etc/fstab file, as in the following
example:

/dev/dvd /dvd iso9660 noauto,ro,user,exec 0 0

However, this option is often omitted from the /etc/fstab file for security
reasons.

2 Start the MathWorks Installer by running the install script.

/dvd/install_unix.sh
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The MathWorks Installer displays theMathWorks Installer dialog box.
Read the information, and then click OK to proceed with the installation.

Note If you need additional help on any step during this installation
process, click the Help button at the bottom of the dialog box.

3 The Software License Agreement displays. If you agree to its terms, click
Yes to continue the installation.

4 Verify the name of the directory in which you want to install MATLAB in
the MATLAB Root Directory dialog box. You can edit the path name
in this dialog box. If the MATLAB root directory is correct, click OK to
proceed with the installation.

Subsequent instructions in this section refer to this directory as
matlabroot.

5 Select the products you want to install in the Installation Options dialog
box.
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The products you are licensed to install appear in the Items to install list
box. If you do not want to install a product, select it in the list and click
Remove. The installer moves the product to the Items not to install list.

To install the complete Student Version, keep all the products listed in the
Items to install list.

After you select the products you want to install, click OK to proceed with
the installation.

6 Specify in the Installation Data dialog box the directory in which you
want to install symbolic links to the matlab and mex scripts. Choose a
directory that is common to all users’ paths, such as /usr/local/bin. You
must be logged in as root to do this. If you choose not to set up these links,
you can still run MATLAB; however, you must specify the full path to the
MATLAB startup script. Click OK to proceed with the installation.
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7 Start the installation by clicking OK in the Begin Installation dialog
box. During the installation, the installer displays information about the
status of the installation.

When the installation successfully completes, the Installation Complete
dialog box opens.

8 Click Continue to begin the activation process.

The Activation Overview dialog box displays and describes the steps
in the process, as follows:

You will be prompted either to complete just the first two steps, or to
complete all four steps.

Step 1. Enter your serial number and e-mail address.

Step 2. Provide registration information by creating a MathWorks account.

Some students must also complete Steps 3 and 4.

Step 3. Provide proof of student status.

Step 4. If you receive an e-mail indicating you have been authenticated,
follow the instructions in that e-mail to complete the activation.
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9 Click Next.

The Student Use Policy dialog box displays. If you are a student using the
software for course work at a school, college, or university, select Yes and
then click Next. Otherwise, select No, and then click Cancel. You cannot
use this software if you do not fit the description presented in this dialog
box.

10 Follow the steps through the activation process.

At the completion of the activation process, you will be able to use Student
Version.

In certain cases, your software will be temporarily activated for 30 days
until your proof of student status is verified. In these cases, you will be
reminded that your activation is temporary and that you need to complete
the activation process. After your proof of student status is verified, your
activation is complete.

Note If you encounter a problem during the activation process, check
www.mathworks.com/academia/student_version/activation.html for
more information.
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11 Start MATLAB by entering the matlab command. If you did not set up
symbolic links in a directory on your path, you must provide the full path to
the matlab command:

matlabroot/bin/matlab

where matlabroot represents your MATLAB installation directory.

Installing Additional Products
To purchase additional products, visit the MathWorks Store at
www.mathworks.com/store. After you purchase a product, the product and
its online documentation are downloaded to your computer.
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